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Send Us Your Comments

Oracle Retail Sales Audit Do the Basics User Guide, Release 24.0.101.0

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this
document.

Your feedback is important, and helps us to best meet your needs as a user of our products.
For example:

e Are the implementation steps correct and complete?

* Did you understand the context of the procedures?

* Did you find any errors in the information?

* Does the structure of the information help you with your tasks?

* Do you need different information or graphics? If so, where, and in what format?
e Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your
name, the name of the company who has licensed our products, the title and part number of
the documentation and the chapter, section, and page number (if available).

@® Note

Before sending us your comments, you might like to check that you have the latest
version of the document and if any concerns are already addressed. To do this,
access the Online Documentation available on the Oracle Technology Network Web
site. It contains the most current Documentation Library plus all documents revised or
released recently.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com
Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative
or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle
local office and inquire about our Oracle University offerings. A list of Oracle offices is available
on our Web site at http://www.oracle.com.
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Preface

This document describes the Oracle Retail Sales Audit user interface. It provides step-by-step
instructions to complete most tasks that can be performed through the user interface.

Audience

This document is for users and administrators of Oracle Retail Sales Audit. This includes
merchandisers, buyers, business analysts, and administrative personnel.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/l ookup?ctx=acc& id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My
Oracle Support. For information, visit http://www.oracle.com/pls'topic/lookup?ctx=acc& id=info or visit http://
www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

e Product version and program/module name

* Functional and technical description of the problem (include business impact)
* Detailed step-by-step instructions to re-create

* Exact error message received

e Screen shots of each step you take

Improved Process for Oracle Retail Documentation Corrections

To more quickly address critical corrections to Oracle Retail documentation content, Oracle
Retail documentation may be republished whenever a critical correction is needed. For critical
corrections, the republication of an Oracle Retail document may at times not be attached to a
numbered software release; instead, the Oracle Retail document will simply be replaced on the
Oracle Technology Network Web site, or, in the case of Data Models, to the applicable My
Oracle Support Documentation container where they reside.

Oracle Retail product documentation is available on the following web site:
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https://docs.oracle.com/en/industries/retail/index.html

An updated version of the applicable Oracle Retail document is indicated by Oracle part
number, as well as print date (month and year). An updated version uses the same part
number, with a higher-numbered suffix. For example, part number E123456-02 is an updated
version of a document with part number E123456-01.

If a more recent version of a document is available, that version supersedes all previous
versions.

Oracle Help Center (docs.oracle.com)

Oracle Retail product documentation is available on the following web site:

https://docs.oracle.com/en/industries/retail/index.html

(Data Model documents can be obtained through My Oracle Support.)

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLSs, code in
examples, text that appears on the screen, or text that you enter.
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Log In and Out

Before you can do anything in an Oracle Retail application, you must log in to the application.

And when you are done, you must log out. This chapter describes these processes.

Log On to the Application

To log on to the application:

1.

4,

Click the User list menu on the top right of the Oracle Sales Audit window.

Figure 1-1 User List Menu

Acoessibility  Chril+Alt+A

Lagin Chri+Al+L

Click Login. The Welcome screen appears.

Figure 1-2 Welcome Screen

Welcome

M
Username

*
Password

Login

Provide the following login information:

a. Enter your user name in the Username field.

b. Enter your password in the Password field.

Click Login.

Log Out of the Application

Use the User list menu, which is to the top right of the Oracle Retail Sales Audit window, to log

out

Do the Basics User Guide
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Log Out of the Application

Figure 1-3 Logging Out of the Application

o I

Preferences Cir+Alt+E

Logout Chri+Alt+0
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User Help

This application contains an online HTML help that can guide you through the user interface.
User information is included to describe high-level processes and procedures, as well as
provide step-by-step instructions for completing a task.

You can access online help for a particular page by clicking on the Help link at the top of the

3
application home page or by clicking the Help icon @ . Once in the help, you can access
additional information through the table of contents or by using the index.
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Common Actions and Icons

Oracle Retail applications, such as, Oracle Retail Sales Audit, include some common interface
options and controls that you can use throughout the application workflow. The following
sections describe these user interface controls in more detail.

Although you may have more than one Oracle Retail application installed on your system, each
application may use many of the same interface components and abide by common rules and
constraints.

The following topics are covered in this chapter:

e Task Bar Options

* Table Level

Task Bar Options

You can quickly access the tasks of current applications and switch to other applications from
the Navigation bar.

Figure 3-1 Navigation Bar

E <=— Application Navigator

«—— Favorites
-—— lasks

{25 — Notifications

III' «— Reporis

The following Navigation bar options are common across all the applications:

*  Application Navigator
* Favorites

e Tasks

Do the Basics User Guide
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Task Bar Options

* Notifications

* Reports

Application Navigator

The Application Navigator is optional for the application and provides the ability to switch
between applications.

@® Note

Your view may vary, depending upon the features selected during the setup process.

To switch between applications:

1. Atthe top left of the application, click the Application Navigator icon to open the list
of available applications.

Figure 3-2 Application Navigator

E Application Navigator

* +" Sales Audit

2. Select the listed applications. The application will open in a new tab.

Favorites

You can select your favorite tasks without accessing the Tasks menu. It helps you quickly get
into your frequently used tasks.

You can click the Favorites icon in the Tasks menu to access tasks designated as favorites.
You can also select the cog icon from the Favorites menu to edit the favorite list. Tasks can be
selected or deselected as favorites in the Tasks menu.

Do the Basics User Guide
G39824-02 August 7, 2025
Copyright © 2025, Oracle and/or its affiliates. Page 2 of 13



ORACLE’

Tasks

Chapter 3
Task Bar Options

Figure 3-3 Favorites Area

Favorites 03

. Store Day Audit

Create Transaction

Manage Transactions
Total Audit Trail

[tem Summary

Oracle Retail applications support a variety of navigational tools and methods that allow you to
move efficiently between application pages. Information on how to use and manage each of
the tools and methods is included in this section.

A task is a set of links to a series of task flows organized in a specific sequence to accomplish
a business process or procedure. For example, tasks can be defined for common multi-step
procedures or processes so that you can quickly step through tasks. By navigating sequentially
to the pages outlined in the task, you are assisted in stepping through the business process or
activity.

Your Tasks list appears on the extreme left side of the home page. All of the tasks to which you
have access appear in the list on the Tasks window. You can either click on the specific task
name to open or use the Task Search component to search for a Task that you want to open.

To begin working with a task, choose the application feature or process from the list.

@ Note

Your Tasks menu may appear slightly different, depending on your retail application.
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Screen Level

Figure 3-4 Tasks Menu

Operations v ) ’\ Data Loading v
<_Foundation Data \

:-'T:\ Search for a task My ek

-\ Search for a task

Download Data
Create Transaction

. Upload Data

Manage Transactions Create Total Definition

Review Status
Bank ACH Manage Total Definitions
Store ACH Create Audit Rule <_Application Administration
General Ledger Transactions Manage Audit Rules =

! \,  Search for a task

Total Audit Trail Bank Stores
ftem Summary Data Loading Etrployess
Tender Summary Application Administration System Options

Reports

The functionality of Reports works similar to the Tasks menu.

Figure 3-5 Reports

Reports

FeSA Dashboard

»

Credit Card Summary Report
Flash Sales Report

[E—

Flash Totals Report

Voucher Activity Report

Screen Level

The screen level actions display the icons and buttons.
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Table Level
Figure 3-6 Screen Level Action - Icons and Buttons
2 'T{-‘}J |,|:.J:J x® Submit = More Actions - Save  Save and Close  Cancel
Table 3-1 Screen Level Action - Icons/Buttons and Descriptions
Icon/Buttons Description
. 2 You can access online help for a particular page by clicking the Hel
Help icon '.:.J . P P page by 9 P
icon.
E_xpandgnd Collapse icon You can view all and collapse all the sections in the application window
=-1+'ij I;':J by clicking the Expand and Collapse icon.
x You can delete a component by selecting the Delete icon.
Delete icon
Status Action Button Depending on the status of your record, the status action button
displays. For example, Submit.
Wherever applicable, this button will be available to change the status
of an entity. The status will be changed to the label specified on the
button. If there is more than one status to which the entity can be
changed, clicking the arrow on the right side of the button will display
the additional status options.
More Actions The More Actions button will have any additional actions and options
for navigating to other screens.
Save Click Save to save the entered records.
Save and Close Click Save and Close to save the records and exit the window.
Cancel Click Cancel to reject your entries and exit the window.

View all the Sections Within a Window

You can view all the sections in the Deal window by clicking the Expand icon "l You can

shrink all the sections in the Deal window by clicking the Shrink icon =

Table Level

@® Note

»  Figure 3-7, Figure 3-8, Figure 3-9 are mere representation and may be different
for every window/table/popup.

The Actions menu, View menu, and icons are displayed in the form of a table. For more
information on these options, see the sections Action Menu and Icons and View Menu.

Action Menu and Icons

The Actions menu provides the option to take different actions related to entries in the table.
Depending on the nature of the table, these actions can be add, view, delete or edit table rows,

Do the Basics User Guide
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Chapter 3
Table Level

create by moving to a new screen or export the table contents to the spreadsheet. Alternatively
these actions can also be performed by using the icon buttons on the table toolbar. For more
information on the icon/buttons, see the Screen Level.

In some tables, it may also contain some table specific actions.

Figure 3-7 Actions Menu and Icons of Components Section

4 Components

Add

Export to Excel

7 3 iy oy = Detach Wrap

Table 3-2 Actions Menul/lcons and Descriptions of Components Section

Actions Menul/lcon

Description

Add and Add icon +

Edit and Edit icon /

Delete and Delete icon x

Export to Excel icon

Wrap icon

You can add a component by clicking Add from the Actions menu or by

clicking the Add icon .

For more information on adding a component, see “To Add an Item to a
Transaction" in the Oracle Retail Sales Audit Auditing Transactions
User Guide.

You can edit a component by clicking Edit from the Actions menu or by

clicking the Edit icon /

For more information on editing a component, see “Edit Totals" in the
Oracle Retail Sales Audit Foundation Data User Guide.

You can delete a component by clicking Delete from the Actions menu

or by clicking the Delete icon x

For more information on deleting a component, see “Deleting a Bank
ACH Transaction Amount" in the Oracle Retail Sales Audit Auditing
Transactions User Guide.

You can save the table to a Microsoft Excel spreadsheet by clicking the
Export to Excel option from the Actions menu or by clicking the Export

B
to Excel icon .
You can wrap the values in the table column by using the Wrap icon

option.
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Table Level

Figure 3-8 Actions Menu and Icons of Audit Rule Search
View- [§ Z & & E | 5 Detach
Create
Create from Existing
Edit
View

Export to Excel

Table 3-3 Actions Menullcons and Descriptions of Audit Rule Search

Actions Menulicon Description

. You can create an audit rule by clicking Create from the Actions menu
Create and Create icon

4
or by clicking the Create icon .
Edit and Edit icon / You can edit an audit rule by clicking Edit from the Actions menu or
clicking the Edit icon /

View and View icon &2 You can view an audit rule by clicking View from the Actions menu or
clicking the View icon ixd,

. You can save the table to a Microsoft Excel spreadsheet by clicking the
Export to Excel icon Export to Excel option from the Actions menu or by clicking the Export

to Excel icon .

Wrap icon You can wrap the values in the table column by using the Wrap icon

option.

View Menu

The View menu provides the options for managing the table columns and sorting and filtering
the table data.

In some tables you have the option to choose a saved custom view, which is an arrangement
of columns different from the default view of the table.

Do the Basics User Guide
G39824-02 August 7, 2025
Copyright © 2025, Oracle and/or its affiliates. Page 7 of 13



ORACLE’

Chapter 3
Search Screens

Figure 3-9 View Menu of Components Section

View =

Columns
Detach

Sort

Rearder Columns...

Query by Example

Table 3-4 Components Section - View Menu and Descriptions

View Menu List

Description

Columns

Detach

Sort

Reorder Columns

Query by Example

You can manage which of the columns will be shown in the table by
clicking the Show All and Manage Columns options.

You can view the tables in the application in a separate window by

clicking Detach or by clicking the Detach icon ‘-jl

You can sort columns by the following options:

e Ascending

e Descending

e Advanced

You can reorder columns by clicking the Reorder Columns option.

You can filter components by one of multiple column values by clicking
the Query by Example option or by clicking the query by example icon

"y

¥,

Search Screens

You can search for a particular entity by entering, selecting, or searching in the Merchandising
Operations Management (MOM) application, for example to search for a deal.

To search for a deal:

1. From the Tasks menu, select Orders > Deals > Manage Deal. The Deal Search window

appears.

2. You can search for a deal by providing search criteria in the search section. The criteria
can be provided either in Basic or Advanced mode, depending on the requirement. Basic is
the default mode when the search screen is entered. Click Advanced to access the search
panel in advanced mode. You can return to Basic mode by clicking Basic.

Search for a Deal Through the Basic Search Criteria

To search for a deal through the basic search criteria:

Do the Basics User Guide
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Search Screens

1. Enter or select one or all of the following basic search criteria.

Table 3-5 Basic Search Criteria

Search Field Description
Deal Enter the deal ID.
Deal Type Select the deal type. The options are: Annual, Promotional, PO

Specific, and Vendor Funded Markdown.

Status Select the status of the deal. The options are: Worksheet,
Submitted, Approved, Rejected, Closed.

Billing Type Select the type of deal being created. The options are: Off invoice,
Bill Back, Bill Back Rebate, Vendor Funded Promotion, Vendor
Funded Markdown.

Vendor Type Select the vendor type.
Vendor Enter, select or search for the vendor.
Active Date Enter the date on which the deal becomes active, or click the

calendar icon and select the date.

Close Date Enter the date on which the deal ends, or click the calendar icon
and select the date.

Figure 3-10 Search Section in Basic Search Mode

Deal Search %

4 Search Advanced Saved Search 1 ¥
Deal Vendor Type v
Deal Type v Vendor -
Status A Active Date -
Billing Type v Close Date i

Search ~ Reset  Save..

2. You can also click on the Saved Search drop down to select one of the saved sets of
search criteria. Selecting a saved search will populate the criteria section with saved
criteria. If the saved search is selected to run automatically then the search will be
executed too. You can also choose to manage and personalize the saved searches by
clicking Personalize in the list. The Personalize Saved Searches window appears. For
more information on the Personalize Saved Searches, see the section Personalize Saved
Search.

3. Click Search. The deals that match the search criteria are displayed in the Results section.

Do the Basics User Guide
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Figure 3-11 Search Results

Dasl Saarch X

Search

Deal

- =
sutue onee [ ]
- =

Vandor Typs
vendor
Activa Date
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Click Reset to execute the saved search.

Chapter 3
Search Screens

Aavancsa | Seved sesrcn =

Soarch || Rosat || Save._

[ »

Total Recoras: 7

Dm.|

Click the Save.. button to save the current set of search criteria as a Saved Search. The
Create Saved Search window appears. For information on the Create Saved Search

window, see the section Create Saved Search.

Click Done to close the window.

To search for a deal through the advanced search criteria:

1.

Do the Basics User Guide
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Enter or select one or all of the following advanced search criteria.

Table 3-6 Advanced Search Criteria

Search Field Description

Deal Enter the deal ID.

Deal Type Select the deal type.

Status Select the status of the deal.

Billing Type Select the type of deal being created.

Vendor Type Select the vendor type.

Vendor Enter, select or search for the vendor.

Active Date Enter the date on which the deal becomes active, or click the
calendar icon and select the date.

Close Date Enter the date on which the deal ends, or click the calendar icon

and select the date.

External Ref. No.

Enter the external reference number.

Order No. Enter, select or search for the order number.

Deal Component Type Select the deal component type.

Rebate Select Yes if the rebate is included in the deal or select No if the

rebate is not included in the deal.
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Table 3-6 (Cont.) Advanced Search Criteria

Search Field Description

Promotion Enter, select or search the promotion from the list.

Division Enter the division number, select or search for the division name
and number.

Group Enter the group number, select or search for the group name and

number from the list.

Department Enter the department number, select or search for the department
name and number from the list.

Class Enter the class number, select or search for the class name and
number from the list.

Subclass Enter the subclass number, select or search for the subclass name
and number from the list.

Item Enter the item number, or search by using the search icon.

Chain Enter the chain number, select or search for the chain name and
number from the list.

Area Enter the area number, select or search for the area name and
number from the list.

Region Enter the region number, select or search for the region name and
number from the list.

District Enter the district number, select or search for the district name and
number from the list.

Location Enter the location number, select or search for the location name
and number from the list.

Figure 3-12 Search Section in Advanced Search Mode

4 Search Basic Saved Search B
Deal Promation v
DealType = Division v
Status E Group
Billing Type E Department
Vendor Type B Class
Vendor v Subclass v
Active Date B - =] item Q
Close Date & = Chain v
External Ref. No. Area v
Order No. - Region v
Deal Component Type District
Rebate E Location v

Search  Reset  Save..

2. You can also click the Saved Search drop down to select one of the saved sets of search
criteria. Selecting a saved search will populate the criteria section with saved criteria. If the
saved search is selected to run automatically then the search will be executed too. You
can also choose to manage and personalize the saved searches by clicking Personalize in
the list. The Personalize Saved Searches window appears. For more information on the
Personalize Saved Searches, see the section Personalize Saved Search.

3. Click Search. The deals that match the search criteria are displayed in the Results section.

4. Click the Save.. button to save the current set of search criteria as a Saved Search. The
Create Saved Search window appears. For information on the Create Saved Search
window, see the section Create Saved Search.
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5. Click Done to close the window.

Personalize Saved Search

Select Personalize from the Saved Search list to view the personalized saved search. The
Personalize Saved Searches pop up allows you to edit, copy, or delete Saved Searches.

Figure 3-13 Personalize Saved Searches Window

Personalize Saved Searches [ x]

Saved Searches

=]

Delete | Duplicate

|| Setas default
__ Run automatically
__ Show in search list

Apply  OK @ Cancel

Create Saved Search

You can create a Saved Search by selecting the Save button in the Search Criteria panel after
you have entered the criteria for your search. The Save button will call up the Create Saved
Search window where the search is given a name and the user determines whether it should
be the default search as well as whether it should be run automatically.

To view the created saved search:

1. Click the Save.. button. The Create Saved Search window appears.

Figure 3-14 Create Saved Search Window

Create Saved Search [ %}

* Required Name

SearchDealsVOCriteria cop

Set as default
¥ | Run automatically

OK  Cancel
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2. Enter the name of the search.

3. You can also choose to save the combination of the search criteria by selecting the
following check boxes:

e Set as default

*  Run automatically
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Set User Preferences

The Preferences pages are where you specify the default regional, language, and accessibility
settings that you want to use throughout the system.

To set your preferred preferences, click user name > Preferences at the top of the application
home page. The Preferences page appears. The standard preference options available are as
follows:

* Regional
e Language
e Accessibility

To return to the application home page, click Back to Home at the top of the page. The
Preferences pages are where you specify the default regional, language, and accessibility
settings that you want to use throughout the system.

Regional Options

Use the following options to specify the default formats for territory, date, time, number, and
time zone you want to use throughout the system.

Table 4-1 Regional Options

Value Description

Territory Specify the country details.

Date Format Select the date format that you want to use.
Time Format Select the time format that you want to use.
Number Format Select the number format that you want to use.
Time Zone Select the time zone you want to use.

Language Options

Use the following options to specify the default language you want to use throughout the
system.

Table 4-2 Language Options

Value Description
Default Specify the default language you want to use.
Current Session Specify the language you want to use for the current session.
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Accessibility Options

Use the following options to specify the default accessibility preferences you want to use
throughout the system.

Table 4-3 Accessibility Options

Value Description

Accessibility Select the accessibility option you want applied.
Color Contrast Specify the color contrast that you want to use.
Font Size Specify the font size that you want to use.

Accessibility

Accessibility involves making your application usable for differently abled persons such as low
vision or blindness, deafness, or other physical limitations. This means creating applications
that can be used without a mouse (keyboard only), used with a screen reader for blind or low-
vision users, and used without reliance on sound, color, or animation and timing.

The Merchandising solutions provides the ability for users to switch between accessibility
support levels in the application, so that users can choose their desired type of accessibility
support, if required. They do so by exposing a user preferences screen in which the user can
specify the accessibility preferences/mode which will allow the user to operate in that mode.

« Default Mode: By default, the Merchandising solutions a have rich user interface
interaction, and are also accessible through the keyboard. Note that in the default mode,
screen readers cannot access all components. If a visually impaired user is using a screen
reader, it is recommended to use the Screen Reader mode.

e Screen Reader: Merchandising solutions are optimized for use with screen readers. The
Screen Reader mode facilitates the display for visually impaired users, but will degrade the
display for sighted users (without visual impairment.

Additional fine grained accessibility levels as described below are also supported:

* High-contrast: Merchandising solutions can display high-contrast-friendly visual content.
High-contrast mode is intended to make the solutions compatible with operating systems
or browsers that have high-contrast features enabled. For example, they changes its use
of background images and background colors in high-contrast mode to prevent the loss of
visual information. Note that the Merchandising solutions high-contrast mode is more
beneficial if used in conjunction with your browser's or operating system's high-contrast
mode. Also, some users might find it beneficial to use large-font mode along with high-
contrast mode.

* Large-fonts: Merchandising solutions also support browser-zoom-friendly content. In
default mode, most text and many containers have a fixed font size to provide a consistent
and defined look. In large-font mode, text and containers have a scalable font size. This
allows the solutions both to be compatible with browsers that are set to larger font sizes
and to work with browser-zoom capabilities. Note that if you are not using large-font mode
or browser-zoom capabilities, you should disable large-font mode. Some users might also
find it beneficial to use high-contrast mode along with the large-font mode.

Merchandising/Sales Audit provides the ability to switch between the above accessibility
support levels in the application, so that users can choose their desired type of accessibility
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support, if required. It exposes a user preferences screen in which the user can specify the
accessibility preferences/mode which will allow the user to operate in that mode.

Configure Application for Screen Reader Mode

Users can configure their session to the accessibility mode by setting user references on the
home page of the application as shown below. Perform the following procedure to configure a
user preference for screen reader mode.

1. Log into one of the Merchandising solutions. In this example, we use Merchandising.
2. From the application home page, select Preferences from the logged in user menu.
Figure 4-1 Logged-in User Menu

s R Aoun - S

Preferences Citri+Alt+E

RAAC | Preferences }

Logout Ctrl+Alt+O

3. From the Tasks pane, click Accessibility to open the Accessibility tab.

Figure 4-2 Accessibility Tab

Menu =t ORACLE Merchandsing Bk bom
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4. Select Screen Reader to enable accessibility mode, and click Save.
Figure 4-3 Enabling the Screen Reader
Merw = ORALCLE Merchandising L~
Last saved 92916 11:14 PM

....

Reewt S

5. Click on Back to Home to return to the home page. Now the application is enabled in the
screen reader mode to assist a visibly challenged user. Some of the graphical content of
Operational Insights is also displayed in a tabular mode.

Set Accessibility to Default
Perform the following procedure to set Accessibility mode to Default mode.

1. From the application home page, select Preferences from the logged in user menu.

Figure 4-4 Logged-in User Menu

e o - B

Preferences Citrl+Alt+E

RAAC [ Preferences }

Logout Ctri+Alt+O

2. From the Tasks pane, click Accessibility to open the Accessibility tab.
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Figure 4-5 Accessibility Tab

Merw L = ORACLE Merchandsng

Acennsitslity Last saved 929016 11:14 PM

Accesstny ) Detw o

Cotor Comrat ® 22

[T

3. Select Default mode.

Figure 4-6 Accessibility Settings

Menu =t ORACLE’ Merchandising p———
B
Accessibility
Accessidty ® Deutmed

Revert Same

4. Click Save to save the settings.

5. Click Back to Home to return to the home page. Application is returned to default mode
and you can view graphical reports.
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Download/Upload Data from Spreadsheets

Sales Audit allows the setup and configuration of a set of standard templates which allow you
to upload and update data using spreadsheets. These spreadsheets can be uploaded to the
system using the Upload Data window.

The following process is followed to update data for the above Sales Audit modules:

1. Download the spreadsheet template for the module you want to update using the
Download Data window.

2. Make the updates in the spreadsheet.
3. Upload the data using the Upload Data window.

Download Data

To download data as spreadsheets:

1. From the Tasks menu, select Foundation Data > Data Loading > Download Data. The
Download Data window appears.

2. Inthe Template Type field, select the type of template.
The following template types are available:
e Administration
e Finance Administration
e Foundation

3. Inthe Template field, select the template you want to download.

Figure 5-1 Download Data Window for a Template Download from Sales Audit

we:  ORACLE sales Audit RESA_ADMIN
Download Data %
Template Type Foundation v

Template Location Closings v
o Filter Criteria

Location v

Closing Date Equals ~| 2020-01-10
] Download Done

@
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4. |If Location Closings is selected as the Template, Location and Closing Date criteria can be
specified.

5. Click Download.

Upload Data

To upload data using spreadsheets:

1. From the Tasks menu, select Foundation Data > Data Loading > Upload Data. The
Upload Data window appears.

2. Inthe Template Type field, select the type of template.
The following template types are available:
¢ Administration
*  Finance Administration
«  Foundation

3. Inthe Template field, select the template of the spreadsheet.

Figure 5-2 Upload Data Window for a Template Upload into Sales Audit

Upload Data %

Template Type GL Cross Reference E| Process Name Maintain Gl Cross Refe
Template Maintain Gl Cross Reference v Source File | Browse.. | No file selected.
@ ] Upload Done

4. Enter a process name in the Process Name field. The value specified in this field enables
you to find the process created to identify the status of the upload and view any errors that
were identified.

5. Select the spreadsheet to be uploaded in the Source File field.

6. Click Upload. The relevant data corresponding to the template is uploaded into the
spreadsheet file specified.
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View Data Loading Status

The Data Loading Status window allows you to view the status of the upload and download
processes happening in RMS, so that you can rectify the issues associated with the upload/
download process.

The window allows you to drill down to the errors or warnings associated with a selected
upload/download request.

You can access the Data Loading Status window from the Task menu, select Foundation Data
> Data Loading > Review Status. The Data Loading Status window appears.

The Data Loading Status window contains the following sections.

 Table
« Data Loading Status Toolbar

Figure 6-1 Data Loading Status Window

Data Loading Status %

Actions v View v

Process

594723
594723
589723
584724
579725
579724
574723
574723
569724
549723
549723
544724
539727
539726
524723
524723
519726
519726
519725

Process Description

Store Grades - 10/19/16 12:05 AM

Store Grades - 10/19/16 12:05 AM

ltem Master - 10/18/2016 13:19
Purchase Order - 10/18/2016 07:22
Purchase Order - 10/18/20168 07:04
Purchase Order - 10/18/2016 07:02

GL Cross Reference - 10/18/16 4:22 AM
GL Cross Reference - 10/18/16 4:22 AM
Cost Change - 10/18/2016 01:57

Inventory Status and Adjustment Reas...

Inventory Status and Adjustment Reas...

Purchase Order - 10/12/2016 14:20
Item Master - Grid ltem Update Upload.
Item Master - Grid Test Upload 10/12/2
User Defined Attributes - 10/7/16 5:34
User Defined Attributes - 10/7/16 5:34
Differentiators - 10/6/16 8:53 AM
Differentiators - 10/6/16 8:53 AM
Differentiators - 10/6/16 2:35 AM

Columns Hidden 3

Table

® & B = Detach

View Issues

File Name

Store Grades - 10.19.16 12.06 AM.ods

Store Grades - 10.19.16 12.06 AM.ods
REG_MEN_JEAN_US.ods

1064002 0ds

1223.0ds

1223 0ds

GL Cross Reference -30.05.2016 0220 A

GL Cross Reference - 30.05.2016 02 20 A
2016-10-17 23-46-41.320.0ds

Inventory Status and Adjustment Reasons - ..
Inventory Status and Adjustment Reasons - ..
2016-10-1212_15_08.0.0ds

2016-10-12 07_59_29.0.0ds

2016-10-12 07_59_29.0.0ds

User Defined Attributes - 10.7 16 4 50 Al ods
User Defined Attributes - 10.7 16 4 50 AM ods
Differentiators - 10.6.16 8.03 AM.ods
Differentiators - 10.6.16 8.03 AM.ods
Differentiators - 10.6.16 8.03 AM.ods

Template
Category

Foundation
Foundation
ltems

Purchase Orders
Purchase Crders
Purchase Crders
Foundation
Foundation

Cost Changes
Foundation
Foundation
Purchase Orders
ltems

ltems
Foundation
Foundation
Foundation
Foundation

Foundation

Type grocgss_
Foundation RMS Tables
Foundation RMS Tables
ltems RMS Tables
Purchase Orders RMS Tables
Purchase Orders RMS Tables
Purchase Orders RMS Tables
Finance Administration  RMS Tables
Finance Administration  RMS Tables

Cost Changes
Inventory
Inventory
Purchase Orders
ltems

Items

Items

Items

ltems

Items

ltems

Staging Tables
RMS Tables
RMS Tables
RMS Tables
RMS Tables
RMS Tables
RMS Tables
RMS Tables
RMS Tables
RMS Tables
RMS Tables

5 Save

Action
DateTime

10/18/16
10/1816
10/18/16
10/18/16
10/1816
10/1816
10/18M6
10/1816
10/17TH6
1011316
1001316
10012116
1001216
10/1216
10716
107116
10/616
10/6/16
10/6116

Status

Processed1
Processed
Processed
Processed1
Processed 1
Processed
Processed
Processed 1
Processed !
Processed1
Processed
Processed1
Processed !
Processed !
Processed !
Processed !
Processed
Processed1
Processed

3

Total Records: 5277

Save and Close

Cancel

The table displays the process, process description, file name, template category and type,

destination, action date and time, status and the user, who initiated the process.
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Table - Actions Menu and Icons

Use the Actions Menu and icons to apply actions to the table. You can perform the actions
listed below.

Table 6-1 Data Loading Status Table - Actions Menul/lcons and Description

Actions Menullcons Description

You can delete a process by using the following steps:
*  Select arecord in the table.

Delete and Delete icon x

Select Actions > Delete or use the Delete icon x
*  You are prompted, if you want to delete the record. Select Yes to
confirm the prompt.
*  The record is deleted from the table.
Export to Excel and Exportto  You can export the records in the table to a Microsoft Excel
Excel icon spreadsheet by selecting Actions > Export to Excel or by using the

Export to Excel icon .

View Issues and View Issues  To view the warnings and errors associated with a selected upload/
button download request:
e Select arecord in the table.
*  Select Actions > View Issues or use the View Issues button. The
Issues window appears.
e Click Done to close the window.

Upload to RMS With this option you can upload the selected process from Staging to
RMS.
This option is only enabled for records which have Staging Tables as a
destination and do not hold the status “Processed with Errors".
Additionally, this option is only enabled for Item induction, Cost Change
induction and Order induction records.

Download Staged This option allows you to download the staged records of a process to
a spreadsheet.
e Select arecord in the table.
*  Select Actions > Download Staged. The staged record are
downloaded to your desktop.

This option is only enabled for Item induction, Cost Change induction
and Order induction records.

Data Loading Status - View Menu and Icons

You can customize the view of the table by using the options in the View Menu.

Table 6-2 Table Data Loading Status - View Menu/lcons and Description

View Menullcons Description

Columns You can manage which of the columns will be shown in the table by
clicking the Show All and Manage Columns options.

) l:.f You can view the table in the application in a separate window by
Detach and Detach icon

clicking Detach or by using the Detach icon #
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Table 6-2 (Cont.) Table Data Loading Status - View Menullcons and Description

View Menul/lcons

Description

Sort

Reorder Columns

Query by Example and Query

by Example icon =4

You can sort columns by the following options:

e Ascending
e Descending
e Advanced

You can reorder columns by clicking the Reorder Columns option.

You can filter the items by one or multiple column values by clicking the

Query by Example option or by using the Query by Example icon ET

Data Loading Status Toolbar

The toolbar contains the following icons and buttons.

Table 6-3 Data Loading Status Toolbar - Icons/Buttons and Description

Icons/Buttons

Description

@

Help icon

Refresh icon @"

Save

Save and Close

Cancel

Done

You can access the online help for a particular page by clicking the
@

You can refresh the window by clicking the Refresh icon. All entries are
reset and not saved.

Help icon

Click Save to save the entered records.

Click Save and Close to save the entered records and close the
window.

Click Cancel to reject all entries and close the window.

If you open the window in view mode, the Done button is displayed.
Click Done to close the window.
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Notifications

Notifications bring events within the application to your attention.

See the following examples:

* A simple, informative message indicating a long-running process has completed

* A message indicating a critical exception has occurred

e The store create request failed

Figure 7-1 Notifications

Notifications

<& ® © pus_apmiN

® 0

® 0

® 0
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Notification Badge

The Notification Badge displays the number of unread notifications for the user in the sidebar
menu. The Notification Badge displays '99+', when there are more than 99 notifications.

The notification count is periodically refreshed at regular intervals. This interval is determined
by a system-configured value.

Figure 7-2 Notification Badge

-

Notification Sidebar

When you click the Notification icon, the Natifications Sidebar is shown displaying the most
recent set of unread natifications (depending on the filter set).
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Figure 7-3 Notifications Sidebar

Notifications - Search Bar

. Search for a notification E— —» Toggle View
Fites @ ~  GroupBy 4 = —» @Grouping Panel
Time Period
Any . —— Filtering Panel
Type
All v
Severity
All v
Reset Filters Apply Cancel

No notifications to display

~ Search Results Panel

See Al — » All Notifications Tab

Each component of the Notifications Sidebar is discussed in detail in the following sections:

Search Bar

A search bar at the top of the panel allows for searching through notifications. The search bar
has auto-suggest enabled, so it displays notifications as the user types.

Right next to the search bar is the 'List/Group’ view toggle button. This causes the Notification
results to be displayed either in a flat or grouped view.
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Figure 7-4 Search Bar

Notifications
Search for a

notification

e x @

The data upload request completed with errors for Process 1630012, (6172) A
Filters

The data upload request completed with errors for Process 1630011, (6171)

LI The data upload request completed with errors for Process 1630010, (61700

® D Thedata upload request completed with errors for Process 1630009, (§1693)
h

T The data upload request completed with errors for Process 1630008, (6163)

17 The data upload request completed with errors for Process 1630007, (6167)
Rl

The data upload request completed with errors for Process 1630008. (6166)
The data upload request completed with errors for Process 1630005. (6165)

TI The data upload request completed with errors for Process 1630004. (6164)

Filtering Panel

The Filtering Panel allows you to filter notifications based on Creation time, Severity and Type.

The values for the Time Periods and Severity components are pre-seeded constants. The Type
drop-down lists all the notification types available in the system.

When you click the Apply button, notifications that match the criteria are shown in the Results
Panel.
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Figure 7-5 Filtering Panel

Filters 0 - Group By M -
Time Period

Any L
Type

All v
Severity

All v
Resat Filters Apply Cancel

Grouping Panel

This panel allows you to group notifications based on different attributes.

The values of the 'Group by' and the 'Then by' components are pre-seeded.

Figure 7-6 Grouping Panel

Filters 0 - Group By 1 =

Group by

Type v
Then by

Mo Selection v
Reset Grouping Apply  Cancel

Results Panel - List View

When no selection is made in the Grouping Panel, the Results Panel displays notifications in a
list format.

The image below shows a simple search without any filtering or grouping.
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Figure 7-7 Results Panel - List View

g

o > ©w

Filters 0 - -0
’ Data upload request faile— .y

'
Mormal h-@

The data upload request c...

118 12:40 PM Il-@
RMS_ADMIN | 9

@ Data upload request faile...

Mormal
The data upload request c...

118 12:48 PM
RMS_ADMIM

Indicates that no filtering was done.

Notification Type - A description of the Type is displayed.

Read/Unread - A blue icon @ is shown next to the natification if it is unread.
Notification Severity - A colored label indicating the severity of the notification is shown.

Description - The description associated with the natification. If the notification was
designed to launch into a relevant flow, then this is displayed as a link. Otherwise, the
description is rendered as plain text.

Creation Time - A timestamp that shows the date and time at which the notification was
created.

User name - Creator of the notification.

Results Panel - Grouped View

Notifications are displayed in a grouped format within the Results Panel, when the Group By
drop-down in the Grouping Panel is selected.

Notifications are displayed in groups with three notifications shown for each group.
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Figure 7-8 Results Panel - Grouped View

Filters 0o - Group By )= = 0

Data upload request faile. My Il-g

@ Data upload request faile...
Mormal
The data upload request ...
/13 12:48 PM

RMS_ADMIN

@ Data upload request faile...

Mormal
The data upload request ...
118 12:48 PM

RME_ADMIN

@ Data upload reguest faile...

Mormal
The data upload request ...

118018 12:42 PM
RMS_ADMIN
See Maore

1. Indicates the Group-By drop-down is selected on the Grouping Panel.

2. The value of the Group-By attribute. In this example, the results were grouped by
Notification Type. Hence the Notification Type is shown as the header of the group.

For each group, three notifications are shown followed by a 'See More' link. When you click
this link, up to 25 notifications are displayed for that group.

Results Panel - Summarized View

Notifications are summarized as shown in this example, when both the Group By and the Then
By drop-downs in the Grouping Panel are selected.

The summary view displays various groups and within them subgroups based on the
selections on the Grouping Panel. For each subgroup, a count of the notifications within that
subgroup, grouped by severity is displayed.

The example below depicts a grouping by department, then by class.
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Figure 7-9 Results Panel - Summarized View

Filters 0 -~ Group By 2—-—!-9

depti ";@

class2 | .—I- @=@
-9
111217 3:36 PM ;@

class1 .

11217 3:36 PM

2345

234 5

1 Important ||| 4 Normal
1/8/17 1:02 AM

Indicates that both options on the Grouping Panel have been selected.

First level of grouping is by Department. Here the first department shown is 'deptl’.
The subgroup within department 'deptl'. In this example, this is the Class name.
The number of natifications within that combination of Group and Subgroup.

A grouping by severity of all notifications within that combination of Group and Subgroup.

© a & 0w N PR

The timestamp of the most recent notification of that combination of Group and Subgroup.

All Notifications Tab

The All Notifications tab is shown when you click the 'See All' link at the bottom of the
Notifications side panel.
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Figure 7-10 All Notifications

ORACLE’ Merchandising

Notifications  x

& RMS_ADMIN v @) «

© Al Notifications ©  Anunread ® Critical Important Normal
796
753 No data to display No data to display 753
Read Unread
43 753

Actions v View v Format & [ B I Detach
Severity Status Description Type P Creation Date Created By Last Updated Date Last
Normal ® The replenishment file upload request completed Replenishment file upload request complete | RMS_ADMIN 9/26M7 2:30 AM RMS_ADMIN  9/26/17 2:30 AM RMS A
Normal [ ] The replenishment file upload request completed Replenishment file upload request complete  RMS_ADMIN 972617 231 AM RMS_ADMIN  9/26/17 2:31 AM RMS
Normal [ ] The replenishment file upload request completed. Replenishment file upload request complete  RMS_ADMIN 92617 2:32 AM RMS_ADMIN  9/26/17 2:32 AM RMS
Normal [ ] The replenishment file upload request completed. Replenishment file upload request complete  RMS_ADMIN 9/26M7 529 AM  RMS_ADMIN  9/26/17 5:29 AM RMS
Normal Q The replenishment file upload reguest completed. Replenishment file upload request complete  RMS_ADMIN 12/6M7 258 AM RMS_ADMIN  12/6/17 2:58 PM RMS
Normal [ ] The replenishment file upload request completed. Replenishment file upload request complete  RMS_ADMIN 9/2517 9:28 AM RMS_ADMIN  9/25/17 9:28 AM RMS
Normal [ ] The replenishment file upload request completed. Replenishment file upload request complete  RMS_ADMIN 9/25M17928 AM  RMS_ADMIN  9/25/17 9:28 AM RMS
Normal [ ] The replenishment file upload reguest completed Replenishment file upload request complete  RMS_ADMIN 9/25M7 930 AM  RMS_ADMIN  9/25/17 3:30 AM RMS
Normal [ ] The replenishment file upload request completed. Replenishment file upload request complete  RMS_ADMIN 9/26M17 213 AM RMS_ADMIN  9/26/17 2:13 AM RMS
Normal [ ] The replenishment file upload request completed. Replenishment file upload request complete  RMS_ADMIN 9/26M7 239 AM  RMS_ADMIN  9/26/17 2:39 AM RMS
Normal [ ] The replenishment file upload reguest completed Replenishment file upload request complete  RMS_ADMIN 9/26M7 2240 AM  RMS_ADMIN  9/26/17 2:40 AM RMS
Normal [ ] The replenishment file upload request completed. Replenishment file upload request complete  RMS_ADMIN 1011617 229 AM  RMS_ADMIN  10/18/17 2:28 AM RMS Y

< >

Columns Hidden 10

This tab lists all the Notifications for the logged-in user, regardless of whether they are in Read
or Unread status. Information tiles display a break-up of the total notifications by severity.
Clicking these tiles refreshes the table below to display only those natifications that are

relevant to that tile.

You can perform the following operations from this tab.

Delete x - The table allows for multiple selection and hence multiple notifications can be
deleted at a time. Use the row header to select the row.

Refresh EE - This refreshes the list of notifications in the table.

Mark as Read - Multiple Unread Notifications can be marked as Read by clicking this
button.

Mark as Unread - Multiple Read Noatifications can be marked as Unread by clicking this
button.

Reassign Notifications ¥ _ Notifications can be reassigned to individual recipients or a

group by clicking the Reassign Notifications icon. On selecting a row in the All Notifications
table, and clicking the icon, the reassign notification popup is displayed. The Type is set to
Reassigned by default, and the Severity and Description are pre-populated from the
selected row; you can then change any of these values and assign the notification to one
or more recipients.
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Figure 7-11 Reassign Notification

Reassign Notification (]
Severity Type
Critical E| Reassigned E|
Description

Individual notification reassigned

Choose Recipients Selected

benny| b4

b

Benny Anderson

OK Cancel

The All Notifications table displays the following columns:

Do the Basics User Guide
(G39824-02

Notification Severity - A colored label indicating the Notification Severity.
Status - If the status is unread, an icon @ is shown. Otherwise it is blank.
Description - The description of the notification itself.

Type - The description of the Notification Type for the notification.

Recipients - In case of individual notifications, this column contains the user ID of the user
to whom the notification is assigned. When the notification is assigned to multiple users, it
displays the text 'Multiple' and enables a context popup which lists all the recipients. This
field is empty when the notification is assigned to a group associated with a type.

Creation Date - Timestamp showing the date and time of creation.
Created By - User ID of the user who created the notification.

Last Updated Date - Timestamp showing the date and time when the last update was
made.

Last Updated By - User ID of the user who last updated the notification.
Application ID - Unique identifier that identifies the application. Not visible by default.
Department - The Department associated with the notification. Not visible by default.

Class - The Class associated with the notification. Not visible by default.

August 7, 2025
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* Subclass - The Subclass associated with the notification. Not visible by default.
* Location - The Location associated with the notification. Not visible by default.
e Supplier - The Supplier associated with the naotification. Not visible by default.

« Performance - The Performance value associated with the notification. Not visible by
default.

e Brand - The Brand associated with the notification. Not visible by default.
* Rollup Count - The Rollup Count associated with the notification. Not visible by default.

» Additional Information - Refers to the Additional Information attribute associated with the
notification. Not visible by default.
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Oracle Digital Assistance

The Oracle Retail Sales Audit is integrated with the Oracle Digital Assistant. The Oracle
Digital Assistant (ODA) is an Al-powered platform that enables users to interact with various
business applications and services through natural conversations through chat interfaces. ODA
brings together information, workflows, and assistance from multiple documentation sources
into a single, unified experience.

With ODA, end users can:

* Get Answers Quickly: Ask questions and receive timely, accurate responses to common
gueries about applications, policies, or business processes.

* Personalized Experience: Receive tailored information and notifications based on your
role, preferences, and recent activity.

* Simple Interaction: Use natural language (typing or speaking) to communicate. ODA is
designed to understand common phrases and conversational requests.

For the best experience, access the ODA window by clicking the conversation icon at the
bottom of the screen, state your request or question clearly, and follow prompts or suggestions
as they appear. If ODA cannot resolve your request, consult the documentation or log a service
request to get additional support.

Figure 8-1 Oracle Assistant

Sales Audit

[--- ]l Oracle Assistant
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Figure 8-2 ODA Chat Window

-] Oracle Assistant
CONNECTED

Thu Jul 24, 6:09 PM

Hello! I'm the Oracle Assistant for Retail.

Powered by OCI Generative AL Please check responses for mistakes. Do not share any sensitive information with
this chat agent

So how may | assist you with questions on Retail?

2Zmin ago
[Type your query here <
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audit rules
Audit rules allow you to set your own sales data validation criteria.

business day

A business day is a calendar day except for the retailers running 24x7 operations. The retailers
who operate 24 hours a day and seven days a week may have their Store Day spread to more
than one calendar day. Sales Audit uses the Day Close transactions from the POS application
to define the close of business day.

errors

Errors arise when the conditions of a rule definition are not met. You can either correct these
errors or you can override them.

error impact

Errors arising out of the transaction data validation performed by Sales Audit may have impact
on the export of data to the external systems. At times, the data should not be exported to the
external systems until the error is corrected. At other times, the impact of the error may be very
negligible and limited only to the internal Sales Audit application. In such situations, the data
can be exported to external systems.

escheatment

Escheatment is the process of forwarding money of outstanding, non-expiring vouchers to the
proper governing authorities after a defined period of time from the date of issuance.

The Escheatment functionality in Sales Audit is driven by the hierarchy of Store, Issuer,
Recipient, and HQ. When performing escheatment, Sales Audit checks to determine whether
there is an address for the first level of the hierarchy, the Store. If so, it checks if the state or
country is defined in the Escheatment table in Sales Audit. If the state or country exists on the
table, it then checks to determine whether the Store indicator for that state or country is set to
yes. If so, Sales Audit escheats the money to that state or country. If no state or country exists
for the store, or one does but does not exist on the Escheatment table, or it does exist on the
table but the Store indicator is set to no, then Sales Audit checks the next level, Issuer, and so
on. If no matches are found after Sales Audit checks all four levels of the hierarchy, then the
retailer claims the voucher as income.
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full disclosure

A method of restating data by sending a negation of the entire first statement, then a second
complete statement.

overriding errors

There are some errors that cannot be corrected. For such errors, you need to acknowledge the
error and then override these errors.

report data

Allows you to generate reports, such as, the Flash Sales Report and the Flash Totals Report.

Sales Audit status

Sales Audit maintains status at three different levels, store status, data status, and audit status.
The status associated with Stores level indicates the status of the store, like worksheet, fuel
closed and closed. The status associated with Data level indicates the progress of data upload,
like ready to load, loading, partially loaded, fully loaded, and purging. The status associated
with Audit level indicates whether the sales data is audited, or is in the process of auditing, or if
errors were identified at the store or headquarter for correction.

revision

Revision is an archive of updates made to transactions. Before updating the current data in
transaction tables, a snapshot of the data is maintained as revisions to historical data. This
process includes the following steps:

e Creating a new version of the transaction record.
« Keeping the older version of the record unchanged.
* Moving the older version of the transaction record to a revision table.

Moving the older version to a separate version history table maintains a complete audit trail
and also minimizes the amount of data held in main transaction tables.

rules definition

By providing a Rule Definition in the Sales Audit system, you are actually defining the
conditions that the Sales Audit system should meet to perform an additional level of transaction
data validation.

sales audit

Sales audit is essentially the process of reviewing the point-of-sale transaction data for
accuracy.
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store day

A store day is the time spent between opening cash registers at the start of a calendar day and
closing the registers at the end of the day. For some retailers, a store day spans over more
than one calendar day.

totals

A total is a summation or count of two or more entities. For example, a total can be a
summation of the quantity of items sold in the store on a particular store day.

Totals are captured in the POS or OMS system and imported into Sales Audit. For example,
summation of the quantity of items sold in a store during a particular store day. Totals are used
to perform store balancing, perform analysis within the Sales Audit system to control losses,
generate reports, and to export audited data to external systems. Totals can either be defined
in Sales Audit or imported as reported by POS or OMS.

total definition

By providing a Total Definition in the Sales Audit system, you are actually defining from where
the total values will come into the Sales Audit system.

total level

Total level indicates the level at which the totals are calculated. The total level relates to the
balancing level that is chosen for the system.

total values

This refers to the actual numeric value produced when the Total Definition is run against the
transaction data.

transaction

A transaction is a record of events at a location, which may include sale, return, and exchange
of items. The following is an illustration of the list of attributes that a transaction record may
contain:

» Date and time of transaction
e Salesperson ID

* Register number

e Cashier

e Invoice number

e Item details

e |tem quantity

¢ |tem taxes
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e Discounts

e Transactional taxes
e Tender details

e Customer details

e Paid out details
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